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Introduction

More traditionally known as a character generator, today’s “real-time graphics system” 

is truly high-performance - delivering compelling graphic displays, eye-catching effects, 

breaking news crawls and emergency alerts, enabling modern broadcasters to set their 

look apart with a strong brand identity and gain audience loyalty. Gone are the days 

of proprietary hardware and isolated workflow. Today’s broadcaster is readily adopting 

new technology, embracing HD, reaching a broader audience, streamlining facility-wide 

workflow, cutting operational costs and increasing revenue potential.

The graphics system of choice must keep the pace.

Avid®      Deko® provides ground-breaking technology for efficient broadcast graphics 

creation and play-out to air in demanding, live environments. In production, Deko 

can create a common (single) set of graphic assets that support SD and HD video 

standards – reducing the time it takes to get to air while allowing greater focus on a 

quality broadcast, not quantity of graphics. And, Deko integrates its creative toolset into 

networked news management and editing environments, enabling shared assets and a 

consistent brand throughout an entire broadcast enterprise.

This white paper serves to provide ways in which broadcasters can achieve graphics 

production efficiencies in SD and HD broadcast environments.

Working with Graphic Assets

Photoshop Layers

Adobe Photoshop is a common tool relied on across many art departments. It only 

makes sense that the graphic system must integrate well with this highly valued 

production tool.

Using links to Photoshop layers, you can dramatically reduce the number of required 

graphic assets from the art department and add greater flexibility for updating design 

elements as your look evolves. 

Static design elements are typically created in the art department using common 

industry tools like Adobe Photoshop. Elements created as native Photoshop (.psd) files 

no longer need to be saved as individual .tga or .tif files for transfer to the graphics 

system. Deko has long-time supported Photoshop’s native .psd file format, but only 

as a flattened file. With Deko version 3.0 software or greater, Deko will import actual 

Photoshop layers either all at once by placing them into separate Deko layers or 
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individually by allowing the Deko artist to identify the desired Photoshop layer and it’s 

on screen position. Deko translates the layer name given from Photoshop and the alpha 

channel too. For the art department, this means less work converting design elements. 

For the Deko artist, this means an added flexibility to update graphics more quickly with 

changes from the art department. When changes to the Photoshop file are made, the 

art department can send the updated Photoshop file over the network, and replace the 

existing file. All linked Deko layers and graphics will display the update on recall of  

that graphic. 

File Associations

Links to Photoshop layers are one form of a Deko File Association. More frequent use of 

File Associations in a graphics package can reduce pre-production efforts significantly. 

A File Association is defined as any Deko text or graphic layer that references any other 

file. For example: A Deko graphic file (.dko) can link to a single Deko Motion Effect (.mot) 

– which stores scripting information for animating graphic elements including text, logos 

and clips. That single Motion script can be used for one or hundreds of Deko graphics 

Should edits need to be made in the Motion script, for example – a change of direction, 

this edit made in the single Motion file is applied across all the graphic files that have 

stored links to the Motion Effect file.
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Or, by referencing a single graphic (ex: Chuck Liddell headshot) across many other 

graphics, what is typically a lengthy process to edit the appearance of a large volume of 

graphics is reduced to one step - edit the single referenced graphic!

Edits made to this one file….. 

…will update all of these!

This technique is especially useful in team sports where “home” and “visitor” elements 

change for every new event – but the templates required do not. In the example of a 

team logo, the logo should be created in the largest resolution it would ever be needed 

and more importantly, it should be consistent from logo to logo in scale and on-screen 

position. This will ensure that elements are not cropped or misplaced when changing out 

to new logos. And the logos should be saved to the Deko in any supported format and 

with a filename that identifies the team so it is easily located. You can choose to scale 

and position this logo as desired in the Deko template.
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To make it easy to “swap out” the team logos at every new event, save placeholder 

files, one titled “team_home.tga” and the other “team_visitor.tga”.  When you build the 

on-air graphics, you should reference these files. Before each event, find the home and 

visitor logos named by team and overwrite the “team_visitor.tga” and “team_home.tga” 

placeholder files as appropriate. The Deko graphic will display the updated team logos.

This method can also be applied to sponsor, station, program and other dynamic and 

changing design elements in your broadcast look.

Headshots and Logos

Headshots and logos including station/network id and sponsors are commonly provided 

as static high resolution files that are simply imported to Deko and applied to the Deko 

graphic as a layer. It is not necessary to convert these files to native Deko format. Design 

elements can be exported from the design application as any supported format, but 

more commonly are saved as .tga or .tif as this format stores the alpha channel required 

to key the element over live video.

As Deko accepts input video, headshot elements can be frame-grabbed from tape and 

brought into Photoshop to create the mask that allows it to be keyed over graphics or 

live video. Or they can be imported as a high quality static file. To ensure consistent size 

and layout from headshot to headshot, the static file can be brought into Photoshop 

and cut from a template. Here is a sample template from a real Deko artist used in the 

production of the Ultimate Fighting Championship (UFC). You can see the artist has 

created guides for where to place the headshot – so that it translates properly to the  

on-air graphic created in Deko.

Photoshop headshot template             Same headshot formatted to graphic template

As a recent trend, many broadcasters are choosing to supplement or replace static 

headshots with live video versions of the headshot. Because Deko can import QuickTime 

.mov clips, it is incredibly easy to get moving elements inside of Deko. See the section 

on Working with Video Clips.



�

Creating a Common Set of Graphics for Multiple 
Formats and Aspect Ratios

Creating in HD, Using in SD

With the adoption of HD, broadcasters have much to consider. During the transition to 

HD and perhaps for some time after, HD and SD may need to co-exist. Up-conversion is 

a common solution, but can compromise quality. Those who are programming for both 

SD and HD standards are looking for ways to minimize the effort and cost of producing 

for both. 

With Deko (version 4.0 software and greater), it is possible to compose a single set of 

graphics for use in multiple formats and aspect ratios, such as HD 16:9, SD 4:3, SD 16:9.  

Video clips should be created in the required playout standard.  

As with any process, there are certain rules that govern graphics composition.  If these 

are met, the workflow can be seamless for the art department designing the look, the 

artist creating the graphics package, and the operator playing out to air.  

Rule #1: Graphics should be created in the highest resolution one will use, presumably 

one of the HD standards. You can repurpose that set of graphic elements (.psd, .jpg, 

.tga, .tif files) and Deko graphics in SD 4:3 or 16:9 without having to recompose or alter 

the original elements or graphics in any manner.  

Rule #2: The fundamental design and graphic layout should consider both the extended 

HD (16:9) canvas and the limits of the SD (4:3) canvas.  

See the UFC graphic below for design treatment. 

Composition Tip: Create 4:3 safe title in 16:9 workspace.

4:3 safe-title marker
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When creating a single set of HD graphics for multi-standard playback – you can edit 

Deko’s safe-title marker to display a 4:3 marker as a visual guide while composing in the 

16:9 workspace. 

The default Deko safe-title is 10% from the edge of the screen top, bottom, left and 

right.  To define the 4:3 workspace, go to Options>Preferences>Markers and adjust 

the Left and Right values to 20%.  Any of the graphic elements, templates, etc. that are 

located within this new “20/10” workspace will scale correctly, and appear within  

safe-title in SD 4:3.

When it’s time for air – if broadcasting in SD 4:3, the graphic should be read with “Crop” 

selected as the conversion method for the current aspect ratio of the program. This can 

be set as the default from the File>Open menu when working with HD graphics in an SD 

(4:3) standard. When Deko opens the graphic, the extra information outside of the 4:3 

area will be cropped, rather than squeezing the HD graphic into the SD raster.
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Rule #3: Always have a backup and be ready to restore! As with any production, 

mistakes are inevitable. With a single graphics package serving so many needs – keeping 

a backup on hand is wise. Create a “master” directory on your own portable, external 

drive. Backup your fonts, presets, macros, clip databases, master templates and user 

preference settings to this drive.

Designing for Multiple Standards and Languages

Many broadcasters who are embracing HD while maintaining SD – have incorporated 

a design treatment into their graphics look that, for some, is a design compromise 

but enables a single set of graphics to be created that work in both SD and HD. This 

treatment is commonly called “center cut”. 

Broadcasters who are not keen on this design method, or those who have requirements 

for reaching audiences in unique languages may benefit from Deko’s Multi-Compose 

Technology. With Deko (version 4.0 software or higher) it is possible to save two versions 

of one graphic – for use in either multiple standards (HD or SD) or multiple languages. 

Though Deko already provides built-in intelligence for handling graphics in multiple 

aspect ratios and formats, this feature extends the ability for both versions of one 

graphic to have a unique design treatment, by working from 2 creation canvases. Both 

versions are stored to a single graphic address. The proper version is read based on the 

system setting at time of air. 

Multi-Compose canvases for creation of two versions of a single graphic
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Prepare for Multi-Compose graphics from the Options>Preferences>Alt Compose tab. 

From this window, you can choose your alternate video standard (the primary is the 

current system setting). 

Or you can choose alternate languages by entering the standard “tag” (based on  

the current system setting) and an alternate “tag”. This setting allows broadcasters to 

embed two different languages into their graphics package and removing the need for 

an extra set of graphics and hands during production efforts.

Working with Video Clips

Clip Export Guidelines from AfterEffects and other 

applications

A graphics package goes well beyond static elements. Today’s trends involve  

attention-grabbing elements like looping logos, audio sound effects, flashes and glows 

and gorgeous animations that keep the viewer interested. Incorporating these dynamic 

elements can be easily done using common industry tools and workflows you’re already 

familiar with. 

Using programs like Adobe AfterEffects, video clips are created based on the brand or 

theme of the event and the video resolution intended. Clips can contain key and even 

audio effects that reinforce the impact of the animation. Clips should always be rendered 

based on the video standard of delivery.

While Deko supports a great number of graphic and clip import formats, we recommend 

exporting clips to QuickTime because it’s largely supported and contains fill and key in 

one file. 



Here are export guidelines you can use when creating clips from other applications:

	 •	� QuickTime .MOV format

	 •	� Animation codec

	 •	 Set Pixel Resolution, Frame Size and Rate to match the intended video standard
	 used by the equipment

	 •	� If key: Millions of Colors +

	 •	� If no key: Millions of Colors 

	 •	 If audio: 48,000 kHz, 16-bit, uncompressed 2-channel stereo.

	 •	 If no audio: create empty audio track based on the above settings.

Importing Clips to Deko systems

Video clips can be transferred to Deko either by recording from input video, or  

imported as a file format. When recorded, the clip, its key and audio will be saved to  

the system drive in user-selected file folder. Automatically, the clip appears in Deko’s 

Clip Editor window. 

For importing clips as a file, Avid Deko (version 4 or higher) provides support for Apple’s 

QuickTime format (.MOV). The benefit of using the widely known QuickTime format 

includes a simplified workflow when sharing media across multiple departments and 

venues. QuickTime should be installed on the Deko system during import.  

Clips are imported from Deko’s Clip Editor where they can be previewed, trimmed, 

renamed, looped and other useful functions. The Clip Editor looks to a database on 

the C:\ drive of the Deko system where all the clip properties are stored – like its name, 

duration, and trim points. This is most useful, because you only need to edit your clips 

once – typically at the time they are imported or ingested. When you transfer the clip 

database to another Deko system, all of the user-defined properties go with it. 

Deko internal Clip Editor for browse, trim, loop, playback and other useful functions
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Gathering Data Sources

Real time data allows broadcasters to tell the most accurate and up to date story. There 

are many flexible ways to get data into graphics and keep it live so the information you 

provide to your audience at home is the most relevant it can be. 

In Deko, using the Automation option you can set Deko layers to accept data from 

a newsroom or sports interface that sends data as commands through serial port or 

network connection. Deko layers are set to “Replace” as a layer property and a “Replace 

ID” setting specifies the order in which data will populate Deko layers. Of course, the 

Deko template includes intelligent formatting so the data that is entered appears in the 

look and style intended.

For users without access to a newsroom or scoring interface, Deko Macros can be used 

to link to comma delimited text files. This is the most basic method for automating data.

Or using the Database Access feature, Deko layers can link to columns and rows of  

a MS Access Database or even an Excel spreadsheet. A simple registration of the  

database with Windows sets up the Data Source Name (DSN). It’s this DSN that Deko 

sees, to retrieve all sorts of information into Deko templates and keep them updating  

in real time. 
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In this Excel spreadsheet from the Ultimate Fighting Championship events, fighters  

are listed by bout categories and bio details for every fighter, such as age, reach and 

record, are organized in rows and columns. For country of origin, flag assignments are 

also provided.

 

The pertinent information is 

passed along to the Deko layers, 

allowing changes to be made in 

the referenced spreadsheet as 

opposed to editing every single 

graphic page. The reward is a 

streamlined production and real 

time data accuracy. 

Setting up Deko for the Broadcast

Using Deko Macros

Deko’s Macro language allows users to tap advanced system functions for speeding 

and simplifying repetitive tasks in production and also while on air. It is common for 

Deko operators to learn and create setup macros that establish certain preferences and 

settings specific to layouts, directory paths, video standards, clip databases, etc. These 

functions can be captured as a series of simple commands and saved to a Deko Macro 

(.mcr) file. When the Macro file is invoked either by the operator or as a background 

task when the Deko program is launched, the system will be setup and ready for any 

freelance operator.

For the Ultimate Fighting Championship, the operator created an “init” (initialize) macro 

that was designed to get the system ready to go – again as a background process. 
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When Deko is launched, the following prompt displays, confirming the setup process is 

taking place for the appropriate video standard. 

To get a Macro to run automatically, name it “init.mcr” and save it to the directory C:\

Deko3000\Bin. Many customers create multiple init versions based on the video format 

they need to support. When it’s time for air, choose the init file that invokes the desired 

video standard and your ready to go.

Benefits of Avid Graphics Workflow

With a greater focus on building a strong brand and emotional connection to audiences, 

the tools used throughout production become key to a competitive edge. And 

broadcasters must also maximize their brand in HD. The power of a brand is realized 

when the brand is delivered consistently with the content produced. Those who rely on 

the output of the art department including producers, reporters, editors – must be able 

to access the work and adapt it to their specific needs without changing the look and 

feel, and deploy the results quickly and easily. Minimizing on-air mistakes and improved 

efficiency are also benefits that can be seen. 

Avid Deko tools offer many advantages across many aspects of your environment. 

Throughout production, you can take existing, high-quality Deko graphics created in the 

art department and repurpose them for promotions and other needs. Using PostDeko 

software on nearly any laptop or PC, Deko graphics are opened and edited using all the 

same composition tools as you will find in the online Deko systems. Export almost any 

supported file type for import to Avid and other NLE devices. 
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PostDeko software with Motion creation tools

Likewise, Deko-signature Motion effects can be rendered as QuickTime or other open 

formats using the Make DekoMovie feature and imported to NLE devices.

Deko Motion effect imported as QuickTime .MOV in Avid NewsCutter®

Graphics efficiencies can also extend into the newsroom. With the evolution of MOS 

and now even deeper integration technologies, graphics are easier than ever to assign 

to stories and deliver to air, all while maintaining the intended look and feel of the 

broadcaster’s brand. 
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Deko Select is a plugin to Newsroom Control Systems that allows journalists to preview, 

select and fulfill graphic requirements during story creation. Completed graphics are 

dragged to the script for assignment. The graphic templates store clips and effects, so 

you’re getting all the powerful capabilities of Deko in a streamlined workflow for the 

busiest of newsrooms.

Deko Select Plugin to iNEWS® for fast graphics fulfillment

 
Conclusion

Avid Deko systems range from entry level to advanced, allowing broadcasters of any 

size to benefit from the powerful workflow tools presented in this white paper. From 

full support of common industry applications like AfterEffects and Photoshop, to the 

creation of compelling Deko-signature effects that you can share throughout your entire 

broadcast enterprise – you’ll find tools that help you to set your look apart and improve 

the speed and efficiency of production.

For additional instruction on any of the Deko features mentioned, refer to your Deko User 

Guide. For more information on Deko products, visit www.avid.com/deko 

We would like to thank Zuffa, LLC for use of Ultimate Fighting Championship graphics 

and images – created using the Avid Deko graphics system. 
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